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Content

• Input analysis

 Specifying input distributions, parameters

 Deterministic vs. random input

 Collecting and using data

 Fitting input distributions  

 Fitting input distributions via Arena Input Analyzer

 No data?
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Deterministic vs. Random Inputs

• In addition to the structural (conceptual) model, we need to 

model the mathematical aspects of the model inputs 

(interarrival time distribution,…) 

 Either observe the system if it exists 

 Or use specifications of the system, collect data, analyze them, and 

come up with reasonable models of how they will be specified in the 

simulation 
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Deterministic vs. Random Inputs

• Deterministic:  nonrandom, fixed values

 Number of units of a resource

 Entity transfer time (?)

 Interarrival, processing times (?)

• Random (stochastic):  model as a distribution, 

“draw” or “generate” values from to drive 

simulation

 Transfer, Interarrival, Processing times

 What distribution?  What distributional parameters?

 Causes simulation output to be random, too

• Don’t just assume randomness away – validity
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Collecting Data

• Generally hard, expensive, frustrating, boring

 System might not exist

 Data available on wrong things (processing time including changeover time) –

might have to change model according to what’s available

 Incomplete, “dirty” data (processing time that includes the failure time)

 Usually either too little data (new system) or Too much data (!)

• Sensitivity of outputs to uncertainty in inputs use sensitivity 

analysis to check the effect of wrong inputs on outputs 

• Match model detail to quality of data: do not detail a part of the model 

without having the required detailed data (reliable)

• Cost of collecting the data – should be budgeted in the project

• Capture variability in data – model validity

• Garbage In, Garbage Out (GIGO)--It means that if invalid data is 

entered in a computer program, the resulting output will also be 

invalid. 
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Using Data:

Alternatives and Issues
• Use data “directly” in simulation

 Read actual observed values to drive model inputs (interarrivals, service 
times, part types, …)

– Arena ReadWrite module ... see Model 10-2 Input.txt (Chapter 10 in 
the textbook)

 All values will be “legal” and realistic

 But can never go outside your observed data

 May not have enough data for long or many runs

 The data may not be valid anymore (e.g. change in the product features)

 Computationally slow (reading disk files)

• Or, fit probability distribution to data

 “Draw” or “generate” synthetic observations (methods for generating 
various types of observations from simulation data) from this 
distribution to drive model inputs

 We’ve done it this way so far

 Can go beyond observed data (good and bad)

 May not get a good “fit” to data – validity?
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Using Data:

Alternatives and Issues
• Be careful when using data

 1000 observations of the time to pass a security gate (airport) are collected 

 Mean = standard deviation = almost 30 seconds  maybe exponentially distributed 
(mean = std deviation, and interarrival time)

 However, usually it takes few seconds to pass through a security gate

 More analysis (Histogram: Figure below)  two populations: one without triggering the 
security alarm and one with the security alarm triggered 

Source: Banks et al., 2010

 Need three models of data:
 One for the time to pass through without setting the 

detector (alarm)

 One for the time to pass through while triggering the 
detector (alarm)

 One for the chance for a person to trigger the alarm 
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Fit probability distribution of data

• Goodness-of-fit tests

– to determine whether data fits a specified distribution (observed and

expected frequencies are significantly different or not)

– to check whether data is independent

– Chi square test (large sample, e.g. N ≥ 50), 

– Kolmogorov-Smirnov (K-S) test (small sample size, e.g. N < 50)

– Most important part: p-value, always between 0 and 1(“Small p” (< 

0.05 or so):  poor fit (try again or give up))

• Probability plot (good for small sample)

• ARENA Input analyzer can help you to fit the     

probability distributions to data observed

Tools > Input Analyzer → load data from an existing data file 

or create a new one

• Minitab/ SPSS software can also be used



Chi-Square Test Statistic

• The test statistic is
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Where:

k = number of categories or cells (classes in the histogram)

p = # of parameters of the hypothesized distribution estimated by sample 

statistics 

Oi = observed frequency for category or cell (class) i
Ei = expected frequency for category or cell i (should be at least five)

H0:  The r.v. conforms to the distributional assumption 

H1:  The r.v. does not conforms to the distributional assumption
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H0:  The r.v. conforms to the distributional assumption 

H1:  The r.v. does not conforms to the distributional assumption

Test statistic:

P-Value = Probability under the chi-square distribution (with (k-p-1) degrees of 

freedom), that is above the computed value of the test statistic
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P-Value = Pr(                    )

For a given level of significance α, find the critical 

level:                 form Chi-square table
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Distribution often used in simulation

• Chi-square test for discrete probability

distribution

 Uniform distribution

 Poisson distribution

• Chi-square test for continuous probability

distribution

 Normal distribution

 Exponential distribution

 Continuous Uniform distribution

 Gamma distribution

 Weibull distribution



Simulation with Arena, 5th ed. Chapter 4 – Modeling Basic Operations and Inputs Slide 12 of 68

Review of discrete distribution: Uniform

Meaning: models incomplete uncertainty  all outcomes are equally likely.

Often inappropriately used when there is no data
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Review of discrete distribution: Poisson

Meaning: models the number of independent events that happens in a fixed amount of time: number of 

customers arriving to a store in one hour
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Review of continuous distribution: Uniform

f(x) = 

μ = 

σ2 = 

F(x) = 

� The probability density function, f(x) of U(a, b):

� The cumulative distribution function, F(x) of U(a, b):

Meaning: models incomplete uncertainty  all outcomes are equally likely.

Often inappropriately used when there is no data
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Review of continuous distribution: Normal

Meaning: Models the distribution of a process that can be thought of as a sum of a number of 

component processes; for example, the time to assemble a product that is the sum of the times of each 

assembly operation. 

- Admits negative values  impossible for time

- Widely used to model population’s characteristics (weight, height,…)



• The general formula for the probability density function of the exponential 

distribution is

where  is the scale parameter (e.g. mean time between successive events). 

The scale parameter is often referred to as  = 1/. 

Thus,

where  is the mean number of events per unit time.

x /1
e       for x 0;    > 0

f (x)

0               otherwise 

    


xexf  )( for x > 0,  > 0

Review of continuous distribution: 

Exponential

Meaning: Models the time between independent events. It is memoryless

If the number of arrivals in one hour (or time unit) follows an Poisson distribution with rate λ, then the 

time between two arrivals is exponential with rate λ, i.e. with mean of =1/λ.
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If x is a exponential random variable with parameter  (or )

The cumulative distribution function is given by,

Review of continuous distribution: 

Exponential
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Parameter estimation from sample data: 

ungrouped data

The sample mean,      , is defined by

And the sample variance, s2, is defined by
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After the distribution has been selected, its parameters should be estimated. 

Preliminary statistics: sample mean and variance as estimators of the hypothesized 

distribution parameters.

For ungrouped (into a frequency histogram) discrete or continuous data:  
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Parameter estimation from sample data: 

discrete grouped data

The sample mean,      , is defined by

And the sample variance, s2, is defined by

k is the number of different values of the variable x (classes) and fi is the observed frequency. 
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Suggested estimators for distribution often 

used in Simulation

Distribution Parameters Estimators

Uniform on (0, b) b

Poisson 

Normal μ, σ2

Exponential 

x̂
22ˆ,ˆ sx     

)/1ˆ/1ˆˆ xx    :(note  

Note: x is a random variable that depends on the sample values

)][max(]/)1[(ˆ
ixnnb 



 = 1722 (= n)

• Are technical support calls equal across all days of the 

week? (i.e., do calls follow a uniform distribution?  = 0.05)

 Sample data for 7 days per of week:

Sum of calls for this day:

Monday 290

Tuesday 250

Wednesday 238

Thursday 257

Friday 265

Saturday 230

Sunday 192

Chi-Square Goodness-of-Fit Test: 

Uniform



 If calls are uniformly distributed, the 1722 calls 

would be expected to be equally divided across the 

7 days (E = np(x) = 1722 x 1/7 = 246):

 Chi-Square Goodness-of-Fit Test: test to 

see if the sample results are consistent with 

the expected results

uniform ifday  per calls expected   246
7

1722


Chi-Square Goodness-of-Fit Test: 

Uniform

Solution:



Observed vs. Expected Frequencies

Observed

Oi

Expected

Ei

Monday

Tuesday

Wednesday

Thursday

Friday

Saturday

Sunday

290

250

238

257

265

230

192

246

246

246

246

246

246

246

TOTAL 1722 1722

Chi-Square Goodness-of-Fit Test: 

Uniform
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...
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H0:  The distribution of calls is uniform over days of the week

H1:  The distribution of calls is not uniform

0

 = .05

Reject H0Do not 
reject H0

2

k-p-1 = 7-0-1 = 6 degrees of freedom:

= 2
.05, 6 = 12.5916

2
.05, 6 = 12.5916

Conclusion:  

2 = 23.05 > 2
,k-p-1 = 12.5916 so 

reject H0 and conclude that the 

distribution is not uniform

Chi-Square Goodness-of-Fit Test: 

Uniform

P-value (at 6 df and χ2 = 23.05) < 0.005

Decision: P-value <  (= 0.05)—reject H0

Simulation with Arena, 5th ed.
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The number of vehicles arriving at the northwest corner of an intersection in 

a 5-minute period between 7:00 a.m. and 7:05 a.m. was monitored for five 

workdays over a 20-week period. The following table shows the resulting 

data. The first entry in the table indicates that there were 12 five-minute 

periods during which zero vehicles arrived, 10 five-minute periods during 

which one vehicle arrived, and so on.

Chi-Square Goodness-of-Fit Test: 

Poisson

Arrivals Arrivals

per Period Frequency per Period    Frequency

0 12 6 7
1 10 7 5
2 19 8 5
3 17 9 3
4 10 10 3
5 8 11 1

Does the number of vehicle arrivals follow a Poisson distribution? 

Consider the significance level  = 0.05

Simulation with Arena, 5th ed.
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Solution:

The random variable (vehicle arrival data) follow a Poisson 

distribution with parameter, 

Chi-Square Goodness-of-Fit Test: 

Poisson

H0: the random variable (vehicle arrival data) is Poisson distributed

H1: the random variable (vehicle arrival data) is not Poisson distributed
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Simulation with Arena, 5th ed.
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Observed Frequency, Expected Frequency,       (Oi - Ei)
2/Ei

xi Oi Ei

0 12 2.6 7.87

1 10    9.6    
2 19 17.4 0.15
3 17 21.1 0.80
4 10 19.2 4.41
5 8 14.0 2.57
6 7 8.5 0.26
7 5 4.4
8 5 2.0
9 3    0.8    11.62

10 3 0.3
11 1 0.1

100 100.0 27.68

Chi-Square Goodness-of-Fit Test: 

Poisson

6.2026.0100)0(

026.0
!0

64.3
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1
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e
xP

x

(Rounded up to one decimal point)

Simulation with Arena, 5th ed.
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Observed Frequency, Expected Frequency,       (Oi - Ei)
2/Ei

xi Oi Ei

0 12 2.6 7.87

1 10    9.6    
2 19 17.4 0.15
3 17 21.1 0.80
4 10 19.2 4.41
5 8 14.0 2.57
6 7 8.5 0.26
7 5 4.4
8 5 2.0
9 3    0.8    11.62

10 3 0.3
11 1 0.1

100 100.0 27.68

Chi-Square Goodness-of-Fit Test: 

Poisson

22 12.2

17 7.6

Since E1 = 2.6 < 5, E1 and E2 are combined and that O1 and O2 are also combined. 

The last five class intervals are also combined for the same reason. Therefore, k is 

also reduced by five. 

Simulation with Arena, 5th ed.
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The calculated is 27.68. The degrees of freedom for the tabulated 

value of 2 is k-p-1 = 7-1-1 = 5. Here, p = 1, since one parameter () was 

estimated from the data. At = 0.05, the critical value is 11.1. 

Thus, H0 would be rejected at level of significance 0.05, i.e., the 

distribution is not Poisson. The analyst must now search for a better-

fitting model or use the empirical distribution of the data.

2
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2
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Chi-Square Goodness-of-Fit Test: 

Poisson
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P-value (at 5 df and χ2 = 27.68) < 0.005

Decision: P-value <  (= 0.05)—reject H0

Decision:

Simulation with Arena, 5th ed.
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Chi-Square test for continuous distribution: 

formation of class intervals

A common practice in constructing the class intervals (or cells) for 

the frequency distribution is to choose the cell boundaries so that 

the expected frequencies  Ei = npi are equal for all cells.

We assume that the Class intervals are equal in probability (instead 

of being equal in width), i.e.,

pi = 1 / k

since Ei = npi =n/k5 ==> n / k 5
and solve for k yields

Where, k is the number of cells and n is the sample size.

k  n / 5

Simulation with Arena, 5th ed.
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Chi-Square Goodness-of-Fit Test: Normal

• Do measurements from a production 

process follow a normal distribution with μ = 

50 and σ = 15?

• Steps:
– Get sample data

– Group sample results into classes (cells)

– (Expected cell frequency must be at least 5 for each cell)

– Compare actual cell frequencies with expected cell 

frequencies

Simulation with Arena, 5th ed.



150 Sample 

Measurements

80

65

36

66

50

38

57

77

59

…etc…

Class Frequency

x < 30 10

30  x < 40 21

40  x < 50 33

50  x < 60 41

60  x < 70 26

70  x < 80 10

80  x < 90 7

90  x 2

TOTAL n=150

• Sample data (integer data) and values grouped into 
classes:

Chi-Square Goodness-of-Fit Test: Normal
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• What are the expected frequencies for these classes 
for a normal distribution with μ = 50 and σ = 15?

Class Frequency

Expected 

Frequency

x < 30 10

30  x < 40 21

40  x < 50 33 ?
50  x < 60 41

60  x < 70 26

70  x < 80 10

80  x < 90 7

90  x 2

TOTAL n=150

Chi-Square Goodness-of-Fit Test: Normal
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Value P(X < value)

Expected 

frequency

x < 30 0.09121 13.68

30  x < 40 0.16128 24.19

40  x < 50 0.24751 37.13

50  x < 60 0.24751 37.13

60  x < 70 0.16128 24.19

70  x < 80 0.06846 10.27

80  x < 90 0.01892 2.84

90  x 0.00383 0.57

TOTAL 1.00000 150.00

Expected frequencies 

in a sample of size 

n=150, from a normal 

distribution with 

μ=50, σ=15

Example:

.0912

1.3333)P(z

15

5030
zP30)P(xP1










 



13.6850)(0.0912)(1  nPE 11

Chi-Square Goodness-of-Fit Test: Normal
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Class
Frequency

(observed, Oi)

Expected 

Frequency,  Ei

x < 30 10 13.68

30  x < 40 21 24.19

40  x < 50 33 37.13

50  x < 60 41 37.13

60  x < 70 26 24.19

70  x < 80 10 10.27

80  x < 90 7 2.84

90  x 2 0.57

TOTAL 150 150.00

 
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i

ii

E
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2 )(

The test statistic is

Chi-Square Goodness-of-Fit Test: Normal

Reject H0, if

2
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 pk

Simulation with Arena, 5th ed. Chapter 4 – Modeling Basic Operations and Inputs Slide 35 of 68



097.12
57.0

)57.02(
...

68.13

)68.1310(

e

)eo( 22

i

2

ii2 








 

H0:  The distribution of the process is normal with μ = 50 and σ = 15

H1:  The distribution of process does not have normal distribution

0

=.05

Reject H0
Do not reject H0

2

df = 8 – 0 – 1 = 7 (p = 0, μ and σ given)

2
.05,7 = 14.0671

Conclusion:  

2 = 12.097 < 2
 = 14.0671 so 

do not reject H0 and that the 

distribution is normal
2

.05 = 14.0671

Chi-Square Goodness-of-Fit Test: Normal
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• A manufacturing engineer is testing a power supply used in a notebook

computer and wishes to determine whether output voltage is adequately

described by a normal distribution. To test the hypothesis, a sample of 100

units are tested and the output voltage are recorded as follows (all data

are not shown here):

3.919, 4.081, 0.062, 1.961, 5.845, 3.027, 6.505, 0.021, 1.192…………..

Mean and standard deviation of the output voltage are estimated based on

sample data and are 5.04 Volt and 0.08 Volt, respectively.

(i) Construct the class intervals so that the expected frequencies are equal for

all cells.

(ii) Conduct the chi-square goodness of fit test to check whether the engineer’s

assumption is correct ( = 0.05).

Chi-Square Goodness-of-Fit Test: Normal 

(class intervals are not given)
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Chi-Square Goodness-of-Fit Test: Normal 

(class intervals are not given)
Solution:

(i) Class intervals
In order to perform the chi-square test with intervals of equal probability (uniform distribution), the 

endpoints of the class intervals must be determined. 

The number of intervals k is given by (n = 100), k  n / 5  k  100 / 5 = 20. 

Suppose k = 8, then each interval will have probability, p = 1/k = 1/8 = 0.125. The endpoints for each 

interval ai are computed from the  cdf for the normal distribution, as follows:
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Replace i by 1, 2, …, 7 and form the class intervals (see next slide)
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Chi-Square Goodness-of-Fit Test: Normal 

(class intervals are not given)

   
948.404.508.015.1    

04.508.0125.0125.01 11

1


  a

  ,125.01    iai
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Chi-Square Goodness-of-Fit Test: Normal 

(class intervals are not given)

(ii) Chi-square test
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Chi-Square Goodness-of-Fit Test: Normal 

(class intervals are not given)



Simulation with Arena, 5th ed. Chapter 4 – Modeling Basic Operations and Inputs Slide 42 of 68

Chi-Square Goodness-of-Fit Test: Normal 

(class intervals are not given)

P-value (at 5 df and χ2 = 0.64) = between 0.975 and 0.99

Decision: P-value >  (= 0.05)—do not reject H0
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• Life tests were performed on a random sample of 50 

PDP-11 electronic chips at 1.5 times the normal 

voltage, and their lifetime (or time to failure) in days 

was recorded:

79.919     3.081    0.062     1.961    5.845    3.027    6.505    0.021    0.012    0.123

6.769   59.899    1.192   34.760    5.009  18.387    0.141  43.565  24.420    0.433

144.695     2.663  17.967     0.091    9.003    0.941    0.878    3.371    2.157    7.579

0.624     5.380    3.148     7.078  23.960    0.590    1.928    0.300    0.002    0.543

7.004   31.764    1.005     1.147    0.219    3.217  14.382    1.008    2.336    4.562

Chi-Square Goodness-of-Fit Test: 

Exponential

Check whether the life of chips follow an exponential 

distribution ( = 0.05)

Simulation with Arena, 5th ed.
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Solution:

The parameter of the exponential distribution is estimated by sample data, 

H0: the chips life is exponentially distributed

H1: the chips life is not exponentially distributed

Chi-Square Goodness-of-Fit Test: 

Exponential

chips/day 084.0
1

days/chip 90.11
50

562.4...081.3919.79











 x

Simulation with Arena, 5th ed.
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In order to perform the chi-square test with intervals of equal probability, the endpoints 

of the class intervals must be determined. The number of intervals should be less than 

or equal to n/5. Here, n=50, so that k  10. Let k = 8, then each interval will have 

probability p =1/k =1/8= 0.125. The endpoints ai for each interval are computed from the  

cdf for the exponential distribution, as follows:

Chi-Square Goodness-of-Fit Test: 

Exponential
















ki

i

a

iii

a

i

a

ii

aakiia

kpia

pie

piaFaaFepi

aeaxPaF

i

i

i

,0  ,1,...,2,1  ),125.01ln(
1

125.08/1/1 note,    ),125.01ln(

1

 )(  thus,,  to0 fromarea  cumulative  theis )( ,1

0 ,1)()(

0









Replace i by 1, 2, …, 7 ( = 0.084): we get a1,…a7 as 1.590, 3.425, 5.595, 

8.252, 11.677, 16.503, and 24.755. Now form the class intervals (see next 

slide)
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Class Observed Frequency, Expected Frequency,       (Oi - Ei)
2 / Ei

Intervlas Oi Ei

x < 1.590        19 6.25 26.01

1.590  x < 3.42         10 6.25 2.25

3.425  x < 5.59          3 6.25 0.81

5.595  x < 8.25          6 6.25 0.01

8.252  x < 11.677        1 6.25 4.41

11.677  x < 16.503        1 6.25 4.41

16.503  x < 24.755        4 6.25 0.81

x > 24.75        6 6.25 0.81

50 50 39.6

Chi-Square Goodness-of-Fit Test: 

Exponential

Simulation with Arena, 5th ed.
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The calculated value of is 39.6. The degrees 

of freedom are given by k - p - 1 = 8 - 1 - 1 = 6. 

At  = 0.05, the tabulated value of is 12.6. 

Since                   , the null hypothesis is rejected, 

i.e. the distribution of chip’s life is not 

exponential. 

2

0

2

6,05.0
2

0

2

6,05.0 

Chi-Square Goodness-of-Fit Test: 

Exponential

P-value (at 6 df and χ2 = 39.6) < 0.005

Decision: P-value <  (= 0.05)—reject H0

Simulation with Arena, 5th ed.



Goodness-of-fit Test: Kolmogorov-Smirnov 

(K-S)

Assumption:
The assumptions are 

1. Sample is a random sample

2. Hypothesized distribution FT(x)  is continuous.

Test Statistic:

• Kolmogorov-Smirnov (K-S) goodness-of-fit test a comparison between 

some theoretical cumulative distribution function, FT(x), and a sample 

cumulative distribution function FS(x).

• The difference between FT(x) and FS(x) is measured by the statistic D
which is the greatest vertical distance between  FS(x) and FT(x) (see the 

figure)
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• When a two sided test is appropriate, that is when the hypothesis are 

H0: FS (x) = FT(x) for all x from - to 
H1: FS (x)  FT(x) for at least one x 

then the statistic is :

D = sup Fs(x) - Ft(x) 
x

which is read, “ D equals the supremum (greatest, or maximum) over all 

x, of the absolute value of the difference Fs(x) - FT(x).”

• The H0 is rejected at the  level of significance if the computed value of 

D exceeds the critical value (from table at given  and n).

• When values of D are based on a discrete theoretical distribution, the 

test is conservative.

• When the test is used with discrete data, then, the true probability of 

committing a type-I error is at most equal to , the stated level of 

significance.

Goodness-of-fit Test: Kolmogorov-Smirnov 

(K-S)
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Example:

The following data points come from an experiment:

1.41 0.26 1.97 0.33 0.55 0.77 1.46 1.18

Is there any evidence to say that the data are randomly sampled from a 

continuous Uniform(0, 2) distribution? ( = 0.05).

Goodness-of-fit Test: Kolmogorov-Smirnov 

(K-S)—Uniform dist.
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Solution:
We assume that the sample available is a random sample from a 

continuous population distribution.

Hypothesis: 

H0: FS(x) = FT(x) for all x from a  to b 

H1: FS(x)  FT(x) for at least one x.
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Goodness-of-fit Test: Kolmogorov-Smirnov 

(K-S)—Uniform dist.



Solution:
We assume that the sample available is a random sample from a 

continuous population distribution.

Hypothesis: 

H0: FS(x) = FT(x) for all x from a  to b 

H1: FS(x)  FT(x) for at least one x.

We get from cont. uniform dist (a = 0, b = 2):

f(x) = 1/(b-a) = 1/2

FT(x) = (x-a)/(b-a)=x/2
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Goodness-of-fit Test: Kolmogorov-Smirnov 

(K-S)—Uniform dist.



X F C.F FS(x)

0.26

0.33

0.55

0.77

1.18

1.41

1.46

1.97

1

1

1

1

1

1

1

1

1

2

3

4

5

6

7

8

0.125

0.250

0.375

0.500

0.625

0.750

0.875

1.000

Decision: 
Here, D (= 0.145) < critical value (= 0.46—from K-S table at n =8, α = 0.05). So we are 

not willing to reject H0, that is the sample may have come from uniform distribution.

X FT(x)

0.26

0.33

0.55

0.77

1.18

1.41

1.46

1.97

0.130

0.165

0.275

0.385

0.590

0.705

0.730

0.985

| FS(x) - FT(x)|

0.005

0.085

0.100

0.115

0.035

0.045

0.145

0.015
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Goodness-of-fit Test: Kolmogorov-Smirnov 

(K-S)—Uniform dist.

Try yourself: 

Test whether the data points (slide # 50) come from an exponential 

distribution with parameter of 2?



Example:
Fasting, blood glucose determinations made on 36 non-obese, 

apparently healthy, adult males are given in the following table. We have 

to test if we may conclude that these data are not from a normally 

distributed population with a mean of 80 and a standard deviation of 6 (
= 0.05).

75            92                80             80              84           72

84            77                81             77              75           81

80            92                72             77              78           76

77            86                77             92              80           78

68            78                92             68              80           81

87            76                80             87              77           86

Goodness-of-fit Test: Kolmogorov-Smirnov 

(K-S)—Normal dist.
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Solution:
We assume that the sample available is a random sample from a 

continuous population distribution.

Hypothesis: 

H0: FS(x) = FT(x) for all x from - to 
H1: FS(x)  FT(x) for at least one x.
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Goodness-of-fit Test: Kolmogorov-Smirnov 

(K-S)—Normal dist.



Distribution of test statistic: 

Critical value of the test statistic for selected values of α and n are given in 

K-S Table.

Decision rule: 

Reject H0 if the computed value of D exceeds 0.226 (the critical value of D for 

n = 36 and  = 0.05– from Table).

Calculation of  test statistic: 

First step is to compute values of FS(x). Each value of FS(x) is obtained by 

dividing the corresponding cumulative frequency by the sample size like 

first value of  FS(x) = 2/36= 0.0556

Value of FT(x) can be obtained by converting each observed value of x to a 

value of the standard normal variable, z. Then find the area between - and 

z.
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Goodness-of-fit Test: Kolmogorov-Smirnov 

(K-S)—Normal dist.



X F C.F FS(x)

68

72

75

76

77

78

80

81

84

86

87

92

2

2

2

2

6

3

6

3

2

2

2

4

2

4

6

8

14

17

23

26

28

30

32

36

.0556

.1111

.1667

.2222

.3889

.4722

.6389

.7222

.7778

.8333

.8889

1.000

Decision: 
Here, D (= 0.1547) < critical value (= 0.226). So we are not willing to reject H0, that is 

the sample may have come from normal distribution.

X Z = (x - 80)/6 FT(x)

68

72

75

76

77

78

80

81

84

86

87

92

-2.00

-1.33

-.83

-.67

-.50

-.33

.00

.17

.67

1.00

1.17

2.00

.0228

.0918

.2033

.2514

.3085

.3707

.5000

.5675

.7486

.8413

.8790

.9772

| FS(x) - FT(x)|

.0328

.0193

.0366

.0292

.0804

.1015

.1389

.1547

.0292

.0080

.0099

.0228
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Goodness-of-fit Test: Kolmogorov-Smirnov 

(K-S)—Normal dist.
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Fitting Distributions to Data

with Arena Input Analyzer

• Assume:

 Have sample data:  Independent and Identically Distributed 

(IID) list of observed values from actual physical system

 Want to select or fit a probability distribution for use in 

generating inputs for simulation model

• Arena Input Analyzer

 Separate application, also via Tools menu in Arena

 Fits distributions, gives valid Arena expression for 

generation to paste directly into simulation model
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Fitting Distributions to Data

with Arena Input Analyzer (cont’d.)

• Fitting = deciding on distribution form 

(exponential, normal, empirical, etc.) and 

estimating its parameters

 Several different methods (Maximum likelihood, moment 

matching, least squares, …)

 Assess goodness of fit via hypothesis tests

– H0: fitted distribution adequately represents data

– Get p value for test (small = poor fit)

• Fitted “theoretical” vs. empirical distribution

• Continuous vs. discrete data, distribution

• “Best” fit from among several distributions
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Data Files for Arena Input Analyzer

• Create data file

 Editor, word processor, spreadsheet, ...

 Plain ASCII text – save as text or export)

 Values separated by white space – blanks, tabs, linefeeds

 Otherwise free format

• Open data file from within Input Analyzer

 File > New or

 File > Data File > Use Existing or 

 Get histogram, basic summary of data

 To see data file:  Window > Input Data

• Generate “fake” data file to play around

 File > Data File > Generate New
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Fit Menu

• Fits distributions, does goodness-of-fit tests

• Fit a specific distribution form

 Plots density over histogram for visual “test”

 Gives exact expression to Copy and Paste (Ctrl+C, Ctrl+V) 

over into simulation model

 May include “offset” depending on distribution

 Gives results of goodness-of-fit tests

– Chi square, Kolmogorov-Smirnov tests

– Most important part:  p-value, always between 0 and 1:

Probability of getting a data set that’s more inconsistent with fitted distribution than 

data set you actually have, if fitted distribution is truly “the truth”

“Small” p (< 0.05 or so):  poor fit (try again or give up)
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Fit Menu (cont’d.)

• Fit all of Arena’s (theoretical) distributions at once

 Fit > Fit All or

 Returns minimum square-error distribution

– Square error = sum of squared discrepancies between histogram 

frequencies and fitted-distribution frequencies

– Can depend on histogram intervals chosen:  different intervals can lead to 

different “best” distribution

 Could still be a poor fit, though (check p value)

 To see all distributions, ranked: Window > Fit All Summary or
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Fit Menu (cont’d.)

• “Fit” Empirical distribution (continuous or discrete):  Fit > Empirical

 Can interpret results as Discrete or Continuous distribution

– Discrete:  get pairs (Cumulative Probability, Value)

– Continuous:  Arena will linearly interpolate within data range according to these pairs 

(so you can never generate values outside range, which might be good or bad)

 Empirical distribution can be used when “theoretical” distributions fit poorly, or 

intentionally
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Issues in Fitting Input Distributions

• Not an exact science – no “right” answer

• Consider theoretical vs. empirical

• Consider range of distribution
 Infinite both ways (e.g., normal)

 Positive (e.g., exponential, gamma)

 Bounded (e.g., beta, uniform)

• Consider ease of parameter manipulation to 
affect means, variances

• Simulation model sensitivity analysis

• Outliers, multimodal data
 Maybe split data set (details in text)
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No Data?

• Happens more often than you’d like

• No good solution; some (bad) options:

 Interview “experts”

– Min, Max:  Uniform

– Avg., % error or absolute error:  Uniform

– Min, Mode, Max:  Triangular

Mode can be different from Mean – allows asymmetry

 Interarrivals – independent, stationary

– Exponential – still need some value for mean

 Number of “random” events in an interval:  Poisson

 Sum of independent “pieces”:  normal (heed left tail ...)

 Product of independent “pieces”:  lognormal
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Cautions on Using Normal Distributions

• Probably most familiar distribution – normal “bell 

curve” used widely in statistical inference

• But it has infinite tails in both directions … in 

particular, has an infinite left tail so can always 

(theoretically) generate negative values

 Many simulation input quantities (e.g., time durations) must 

be positive to make sense – Arena truncates negatives to 0

• If mean  is big relative to standard deviation , 

then P(negative) value is small … one in a million

 But in simulation, one in a million can happen

• Moral – avoid normal as input distribution



Simulation with Arena, 5th ed. Chapter 4 – Modeling Basic Operations and Inputs Slide 67 of 68

See Tutorial-2 (Lecture-5)
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Continued in Lecture 6


